Chapter 13 Applications: Spatial Interpolation

This applications section covers seven tasks. Task 1 covers the global method of trend surface analysis. Tasks 2 to 7 deal with the local interpolation methods of kernel density estimation, inverse distance weighted, thin-plate spline, and kriging. Kriging includes ordinary kriging, detrended kriging, and cokriging. 

You can access the local interpolation methods of inverse distance weighted, spline, and kriging through Spatial Analyst, 3D Analyst, and Geostatistical Analyst. You will use Geostatistical Analyst in this section whenever possible because Geostatistical Analyst provides more information and better user interface than the other extensions. For example, Geostatistical Analyst computes the root-mean-squared error, a cross-validation statistic that shows how closely a model predicts the known values at control points. Therefore, the root-mean-squared error can be used as one of the statistics in comparing models. 

Task 1: Use Trend Surface Analysis for Global Interpolation

What you need: stations.shp, a shapefile containing 105 weather stations in Idaho; idoutl.shp, an Idaho outline shapefile; and idoutlgd, an Idaho outline grid.

In Task 1 you will explore the average annual precipitation from 1961 to 1990 stored in the attribute called ann_prec in stations.shp, before run a trend surface analysis. 

1. Start ArcCatalog, and make connection to the Chapter 13 database. Launch ArcMap. Add stations.shp, idoutl.shp, and idoutlgd to Layers and rename Layers Task 1. Select Extensions from the Tools menu and make sure that both Geostatistical Analyst and Spatial Analyst are checked. Click the View menu, point to Toolbars, and make sure that both Geostatistical Analyst and Spatial Analyst are checked. 

2. Click the Geostatistical Analyst dropdown arrow, point to Explore Data, and select Trend Analysis. At the bottom of the Trend Analysis dialog, click the dropdown arrow to select stations for Layer and ANN_PREC for Attribute. 

3. Maximize the Trend Analysis dialog. The 3D diagram shows two Trend Projections: the YZ Plane dips from north to south, and the XZ plane dips initially from west to east and then rises. The north-south trend is much stronger than the east-west trend, suggesting that the general precipitation pattern in Idaho decreases from north to south. Close the dialog. 

4. Click the Geostatistical Analyst dropdown arrow, and select Geostatistical Wizard. You will first choose the geostatistical method and input data. In the Methods frame, click Global Polynomial Interpolation. Click the Input Data dropdown arrow and select stations. Click the Attribute dropdown arrow and select ANN_PREC. The next panel lets you choose the power of the trend surface model. The Power list provides the choice from 1 to 10. 

5. Select 1 for the Power. The next panel shows scatter plots (Predicted versus Measured values, and Error versus Measured values), and statistics related to the first-order trend surface model. The Root-Mean-Square statistic measures the overall fit of the trend surface model. In this case, it has a value of 5.94. Click Back and change the Power to 2, and click Next. The Root-Mean-Square statistic has a value of 6.03. Repeat the same procedure with other power numbers. The trend surface model with the lowest Root-Mean-Square statistic is considered the best overall model for this task. For ANN_PREC, the best overall model has the power of 5 and the Root-Mean-Square statistic of 3.94. Change the Power to 5, and click Finish. Click OK in the Output Layer Information dialog.

6. Added to the Table of Contents is Global Polynomial Interpolation Prediction Map, which is a Geostatistical Analyst output layer and has the same extent as stations. To clip Global Polynomial Interpolation Prediction Map to fit Idaho, you must first convert the map to a raster grid and then clip the grid using the Spatial Analyst extension.  

7. Right-click Global Polynomial Interpolation Prediction Map, point to Data, and select Export to Raster. In the Export to Raster dialog, enter 2000 (meters) for the Cell Size and specify trend5_grid for the Output Raster. Click OK to dismiss the dialog. Add trend5_grid to the map. (Notice that trend5_grid has cell values ranging from –8 to 1242. Most of those extreme cell values are located outside the state border.) 

8. Now you are ready to clip trend5_grid. Click the Spatial Analyst dropdown arrow and select Options. Under the General tab, select the Chapter 13 database (i.e., chap13) for the working directory and select idoutlgd for the analysis mask. Click OK to dismiss the Options dialog. Click the Spatial Analyst dropdown arrow and select Raster Calculator. Double-click trend5_grid in the Layers frame so that trend5_grid appears in the expression box. Click Evaluate. Calculation is the clipped trend5_grid.

9. You can generate isolines from Calculation for data visualization. Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Contour. In the Contour dialog, make sure that Calculation is the input surface, enter 5 for the contour interval and 0 for the base contour, and specify trend5ctour.shp for the output features. Click OK. Right-click trend5ctour in the Table of Contents and select Properties. Click the Labels tab. Check the box next to Label Features in this layer, select CONTOUR from the Label Field dropdown list, and click OK. The map now shows isoline labels. 

10. Calculation is a temporary grid. You can save it as a permanent grid by going through the following steps: right-click calculation and select Make Permanent, and enter the name for the permanent grid. 

Task 2: Use Kernel Density Estimation for Local Interpolation

What you need: deer.shp, a point shapefile showing deer locations. 

Task 2 uses the kernel estimation method to compute the average number of deer sightings per hectare from deer.shp. Deer location data have a 50-meter minimum discernible distance; therefore, some locations have multiple sightings. 

1. Select Data Frame from the Insert menu in ArcMap. Rename the new data frame Task 2, and add deer.shp to Task 2. Make sure that the Spatial Analyst toolbar is available.

2. Select Properties from the context menu of deer. Click the Symbology tab. Select Quantities and Graduated symbols in the Show box, and select SIGHTINGS from the Value dropdown list. Click OK. The map shows deer sightings at each location in graduated symbols. 

3. Because you have used idoutlgd as the analysis mask in Task 1, you must remove it before proceeding with the next step. Click the Spatial Analyst dropdown arrow and select Options. Under the General tab, select None from the Analysis mask dropdown list. Click OK to dismiss the Options dialog. 

4. Click the Spatial Analyst dropdown arrow, and click Density. You need to work with several parameters in the Density dialog. Make sure that deer is the input data. Select SIGHTINGS from the Population field dropdown list. Make sure that Density type is Kernel. Enter 100 for the search radius. Select Hectares from the Area units dropdown list. Enter 100 for the output cell size. Click OK to dismiss the dialog. Density of deer shows deer sighting densities computed by the kernel estimation method.

5. To see both data sets of deer and density of deer, you can make density of deer transparent. Right-click density of deer in the Table of Contents and select Properties. Under the Display tab, enter 30 next to Transparent and click OK.     

Task 3: Use IDW for Local Interpolation 

What you need: stations.shp and idoutlgd, same as Task 1. 

This task lets you create a precipitation grid using the inverse distance weighted (IDW) method.

1. Select Data Frame from the Insert menu in ArcMap. Rename the new data frame Tasks 3&4, and add stations.shp and idoutlgd to Tasks 3&4. Make sure that the Geostatistical Analyst and Spatial Analyst toolbars are both available.

2. Click the Geostatistical Analyst dropdown arrow and select Geostatistical Wizard. Make sure that Input Data is stations. Select ANN_PREC from the Attribute dropdown list. Click Inverse Distance Weighting in the Methods frame. Click Next. 

3. The Step 1 panel includes a graphic frame and a method frame for specifying IDW parameters. The default IDW method uses the power of 2, 15 neighbors (control points), and a circular area from which control points are selected. The graphic frame shows stations and the points and their weights (shown in percentages and color symbols) used in deriving the estimated value for a test location. You can click the “Predict/Estimate Value and Identify Neighbors in the Center of Ellipse” tool and then click any point within the graphic frame to see how the point’s estimated value is derived. 

4. The Optimize Power Value button is included in the Step 1 panel. Because a change of the power value will change the estimated value at a point location, you can click the button and ask Geostatistical Wizard to find the optimal power value while holding other parameter values constant. Geostatistical Wizard employs the cross-validation technique to find the optimal power value. Click the Optimal button, and the Power field shows a value of 4.2639. Click Next.  

5. The panel for Step 2 allows you to draw scatter plots relating predicted to measured values, or relating error to measured values. The panel also shows statistics of prediction errors. For example, the Root-Mean-Square is 3.322 using the optimal power value of 4.2639, compared to 3.678 using a power value of 2. Click Finish. Click OK in the Output Layer Information dialog. 

6. You can follow the same steps as in Task 1 to convert Inverse Distance Weighting Prediction Map to a grid, to clip the grid by using idoutlgd as the analysis mask, and to create isolines from the clipped grid. 

Task 4: Compare Two Splines Methods 

What you need: stations.shp and idoutlgd, same as Task 3.

Task 4 compares the results from two thin-plate splines methods. The task has three parts: one, create an interpolated grid using the regularized splines method; two, create an interpolated grid using the thin-plate splines with tension method; and three, use a local operation to compare the two grids. The result can show you the difference between the two interpolation methods.

1. Click the Geostatistical Analyst dropdown arrow and select Geostatistical Wizard. Make sure that Input Data is stations. Select ANN_PREC from the Attribute dropdown list. Click Radial Basis Functions in the Methods frame. Click Next.

2. In the Step 1 panel, click the Kernel Functions dropdown arrow and select Completely Regularized Spline. The panel contains other information: the optimal parameter value of 0.00010205, the selection method for neighbors (control points), and a graphic frame showing how the estimated value for a test location is derived. Click Next. 

3. The Step 2 panel shows scatter plots relating predicted to measured values or relating error to measured values and statistics of prediction errors. For example, the Root-Mean-Square is 3.045 using the optimal parameter value of 0.00010205, compared to 3.187 using a parameter value of 0.0002. Click Finish. Click OK in the Output Layer Information dialog.

4. Radial Basis Functions Prediction Map shows the result of the regularized splines method. Right-click Radial Basis Functions Prediction Map, point to Data, and select Export to Raster. In the Export to Raster dialog, change the Cell Size to 2000 (meters) and save the Output Raster as regularized. Click OK to dismiss the dialog. 

5. Now you will create an output raster using the spline with tension method. Click the Geostatistical Analyst dropdown arrow and select Geostatistical Wizard. Make sure that that the input data is stations, the attribute is ANN_PREC, and Radial Basis Functions is the method. Click Next.

6. In the Step 1 panel, select Spline with Tension from the Kernel Functions dropdown list. Notice that the optimal parameter value is 0.000027474. Click Next. 

7. The Step 2 panel shows the Root-Mean-Square of 2.875. Click Finish. Click OK in the Output Layer Information dialog.

8. Right-click Radial Basis Functions_2 Prediction Map, point to Data, and select Export to Raster. In the Export to Raster dialog, change the Cell Size to 2000 (meters) and save the Output Raster as tension. Click OK to dismiss the dialog.

9. Click the Spatial Analyst dropdown arrow and select Options. Make sure that, under the General tab, chap13 is the working directory and idoutlgd is the analysis mask. Click OK to dismiss the dialog. 

10. Select Raster Calculator from the Spatial Analyst dropdown list. Prepare the following expression in the expression box: [regularized] – [tension]. Click Evaluate.

11. Calculation shows the difference in cell values between the two grids, regularized and tension. Right-click Calculation and select Properties. Click the Symbology tab. Click Classify. In the Classification dialog, select 3 in the Classes dropdown list. Click the first cell under Break Values and enter –2. Enter 2 and 2.6 in the next two cells. Click OK in the Classification dialog and the Layer Properties dialog. Calculation now shows the difference between regularized and tension in three classes (< -2, -2-2, and > 2). 

Task 5: Use Ordinary Kriging for Local Interpolation

What you need: stations.shp and idoutlgd, same as Task 3.

Task 5 lets you run ordinary kriging in ArcMap. Kriging is a complex topic and requires expert knowledge in selecting the proper model for the data to be interpolated. For this task as well as the following two tasks, you will use the root-mean-square statistic to select the mathematical model. 

1. Select Data Frame from the Insert menu in ArcMap. Rename the new data frame Tasks 4-7, and add stations.shp and idoutlgd to Tasks 4-7. Click the Geostatistical Analyst dropdown arrow and select Geostatistical Wizard. In the first panel, make sure that Input Data is stations. Select ANN_PREC from the Attribute dropdown list. Click Kriging in the Methods frame. Click Next. 

2. The Step 1 panel lets you choose the kriging method and the map output. Click Ordinary Kriging Prediction Map in the Geostatistical Methods frame. Click Next. 

3. The Step 2 panel shows the semivariogram/covariance view, and the choice of the mathematical models for approximating the semivariogram/covariance. Choose the Exponential model (this model results in the lowest Root-Mean-Square of 2.918, as seen in Step 4). The mathematical equation for the model is shown in the lower left of the panel. Click Next. 

4. The Step 3 panel shows the selection method for neighbors (control points), and a graphic frame showing how the estimated value for a test location is derived. Click Next. 

5. The Step 4 panel shows scatter plots (Predicted versus Measured values, Error versus Measured values, Standardized Error versus Measured values, and Quantile-Quantile plot for Standardized Error values), and statistics related to the model including the Root-Mean-Square. Click Finish. Click OK in the Output Layer Information dialog.

6. Ordinary Kriging Prediction Map is added to the map. To derive a prediction standard error map, you will click the Ordinary Kriging Prediction Standard Error Map in Step 1 and repeat Steps 2 to 4. 

7. You can follow the same steps as in Task 1 to convert Ordinary Kriging Prediction Map and Ordinary Kriging Prediction Standard Error Map to grids, to clip the grids by using idoutlgd as the mask grid, and to create isolines from the clipped grids. 

8. The clipped grid from Ordinary Kriging Prediction Standard Error Map is a variance grid. You can convert it to a standard deviation grid by using Raster Calculator from the Spatial Analyst dropdown list. In the Raster Calculator dialog, you will enter the expression: sqrt([ord_var]), where [ord_var] represents the clipped grid from Ordinary Kriging Prediction Standard Error Map. 

Task 6: Use Universal Kriging for Local Interpolation

What you need: stations.shp and idoutlgd, same as Task 5.

In Task 6 you will run universal kriging in ArcMap. The trend to be removed from the kriging process is the first-order trend surface. 

1. Click the Geostatistical Analyst dropdown arrow and select Geostatistical Wizard. Make sure that the Input Data is stations and the attribute is ANN_PREC. Click Kriging in the Methods frame. Click Next.

2. In the Step 1 panel, click Universal Kriging Prediction Map in the Geostatistical Methods frame. Select First from the Order of Trend dropdown list. Click Next. 

3. The Step 2 panel shows the first-order trend that will be removed from the kriging process. Click Next. 

4. The Step 3 panel shows the semivariogram/covariance view, and the choice of the mathematical models for approximating the semivariogram/covariance. Choose the Gaussian model (this model results in the lowest Root-Mean-Square of 2.911, as seen in Step 4). The mathematical equation for the model is shown in the lower left of the panel. Click Next. 

5. The Step 4 panel shows the selection method for neighbors (control points), and a graphic frame showing how the estimated value for a test location is derived. Click Next. 

6. The Step 5 panel shows scatter plots (Predicted versus Measured values, Error versus Measured values, Standardized Error versus Measured values, and Quantile-Quantile plot for Standardized Error values), and statistics related to the model including the Root-Mean-Square. Click Finish. Click OK in the Output Layer Information dialog. 

7. Universal Kriging Prediction Map is an interpolated map from universal kriging. To derive a prediction standard error map, you will click the Ordinary Kriging Prediction Standard Error Map in Step 1 and repeat Steps 2 to 5. 

8. You can follow the same steps as in Task 1 to convert Universal Kriging Prediction Map and Universal Kriging Prediction Standard Error Map to grids, to clip the grids by using idoutlgd as the mask grid, and to create isolines from the clipped grids. 

Task 7: Use Cokriging for Local Interpolation

What you need: stations.shp and idoutlgd, same as Task 5.

In Task 7 you will run cokriging in ArcMap by using the variables of annual precipitation and elevation. 

1. Click the Geostatistical Analyst dropdown arrow and select Geostatistical Wizard. Click cokriging in the Methods frame. Under the Dataset 1 tab, select stations for Input Data and ANN_PREC for Attribute. Under the Dataset 2 tab, select stations for Input Data and ELEVATION for Attribute. Click Next. 

2. In the Step 1 panel, click Ordinary Cokriging Prediction Map. Click Next. 

3. The Step 2 panel shows the semivariogram/covariance view, and the choice of the mathematical models for approximating the semivariogram/covariance. Choose the Pentaspherical model (this model results in the lowest Root-Mean-Square of 3.363, as seen in Step 4). The mathematical equation for the model is shown in the lower left of the panel. Click Next.

4. The Step 3 panel shows the selection method for neighbors (control points), and a graphic frame showing how the estimated value for a test location is derived. Click Next. 

5. The Step 4 panel shows scatter plots (Predicted versus Measured values, Error versus Measured values, Standardized Error versus Measured values, and Quantile-Quantile plot for Standardized Error values), and statistics related to the model including the Root-Mean-Square. Click Finish. Click OK in the Output Layer Information dialog. 

6. Ordinary Cokriging Prediction Map is an interpolated map from cokriging using ANN_PREC and ELEVATION. To derive a prediction standard error map, you will click the Ordinary Kriging Prediction Standard Error Map in Step 2 and repeat Steps 3 to 5. 

7. You can follow the same steps as in Task 1 to convert Ordinary Cokriging Prediction Map and Ordinary Cokriging Prediction Standard Error Map to grids, to clip the grids by using idoutlgd as the mask grid, and to create isolines from the clipped grids. 

